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ABSTRACT

Currently robotic technology is brought to assist victims from the risk instead of human.
It can reduce human risk during the operation. Therefore the efficient searching system for the
victims is required to make the robot discovered the victims successfully.

This development project is established to apply an object-oriented system development
approach to develope the victims discovering system for a rescue robot under simulated scenario.
The victims discovering system compose of a temperature detection system, sound detection
system, and monitoring system. The rescue robot uses an embedded Lego Mindstroms NXT
model as the hardware in development and Java IDE as the software development tool for Java.
This development project can be applied as the approach in victims discovering system

development for the rescue robot in practice in the future.
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Tsunsuilszgadiilugedduasnlduaudiuaeg  auanuden1sves
{ o © o :
A¥Aaunsainnlflszlonildlagass sldnsiauldazaniu  vieermily
¢ 499 y & NGk £ A gy v o
gevdns IFnumwmzduddidiludgiannimeans immzaunuammnsiauvesay
' ¢ o g ' S do 4 a
ansamisgendnilszgndosmiiuaesnguie seraunidusegl Ae Tusunsungnada
2 = ) 4 ° v ar v
nselouvuuasasouioonda wieuneziillldnuaieg 1dnuil 1wy Microsoft Office
¢ g ' s o ° ¢S @ o
Wudu uazaerdasn 1Famummedn 1y sevanasiszuanad senduiszunliny

wudu

dos [ [ =S
2.2 1B UIFD I IATZAVANNAIYBAUAL
o = St 1Y o = [ 4
[UIFD3 104 (Sound Sensor) iiluatimein1Flumsiaszauanuduides Asgii 2.10
v A s 1Y =) - @ o o ar v A
uailpInINszauANURIveudsslianuFudFouln Tuises aszduanuaudvsveaaln
] < It 2 v U =y Jd < 4
NoARTON JUIBUIBNTH TeeumveuduaaziaaIna lugliuuveulosiTua (%)
@ d d < o r
- fwadnsae 4-5 nlefivud nffeuldnudssluieslon
@ d Jd 3 o Y Y
- fwaansae 5-10 nlesiua nlSouldnndveaugoiuluszeslna
- fwadnsae 10-30 wesiFud niSeulddudssiifaninmsaunumsaidounasnd
anuaslng
PV, sl o o 4 o
- fwaansae 30-100 nlesidua nfSoulanudsens Inunsaidoanasniinnuang
4
uennntiteiaunsasmuamzuuums Sadodldtumuees 14 ez Idiiuuuued

wate (DBA) ¥isomdiiia (DB) lagh
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a I @ 4 [ 9
- ndwaesznineninsniudedlussduiyuesauaunaiyld

a = [ v Ao =) v A [ 9
= mmma‘nmamm'mmmm‘luszaummsaqammmmﬂuﬁxmmsnm'lﬂ

g‘l.l‘?l 2.9 @UIR3 JATEAUANUAUTD (http://www.legoeducation.com/sharedimages/

product/Large/L._9845SoundSensor.jpg)

2.3 1 waes Tngaumgh

e SaguMail (Temperature - Sensor) MFlumaimnszuudumilssduioezy
wuwes Jagaungvesganaansiszuuiadaa Iduoaasen {ue1iHdng  (LEGO
MINDSTROMS RCX) Aa31)ii 2.1 c‘ﬂawuwa{%nqamQﬁﬁ')ﬁ‘vﬁ'ﬂmqmwgﬁ'lﬂ“lmi'n -20
PIAUTALFOT D19 50 DIAUFAFON Tﬂuiumsuﬁmnaqmwgﬁifuazmmimﬁaﬂ‘lﬁ'nmm

pomnluziunvssssmisadianessmwusy lan 14

51l 2.10 e Iagungil (hitp:/www.active-robots.com/products/mindstormsAschools/

lego-spares/tempsensor-500.jpg)

Vv v
2.4 ndeddale 13y
| o @ aa o o A~ Ao 3
dudiAnveendnsin 1o 13 oAoimumes FunN (Image Sensor) FaiintiNFuuasi
9 9 P v ﬂ Y an £ @ A dao v -
Whanudulasusuaailudyananiaea daluilegtiuiimueessuniweg 2 wuufe CCD

(FA) taz CMOS (Fuod)
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2.4.1 NABIFHA
' . R aaa 2 aa . Aa
CCD 8911910 Charge Coupled Device mwmmi‘luﬁmmwmmqmaﬂau (Silicon) Ny
e v £ o Y Ao = U ﬂ o o L
auaia hasuasdazimihnivuawaznasuswauiludyaaeuaen dadigaes
Py U [ Y aa Ads @ 9 an d aa a a Vo
nlasumemaeniludyauainea daaialaiuiluasaeaflauniilss@niamgs uadang
doadiszuuaees fwendranin emmsulasdyane Iwihndannnddad Idaaeilu
o 4 o q ¥ da d 9 'Y a a o A 2 9 oa
mwiail e ldnszuaunsiifaiu dedldnar uaz Imsus Inandanumuau ded
ndeadda Ao dewmildanu anuiansed aunsantuguaalanoluveuaud 18
' ] 4 v [~ [ v
(Auto Iris Control) liifinmdiou lilinansznunInMssunILYBINAUULIMAN BATIAIUVDI
amIagilounuiage3 e lifinnuuande nudemsdu Inrvesduaden wazannsa
o A dda ' v
wawlununitivesainannla
2.4.2 NdLIFNBT
CMOS 86931910 Complementary Metal Oxide Semiconductor. iunsaauaaiy
a [y @ - o
i TuTadves luTassvndaulasiiiudunlasaadidiunszua i Sueaihuauwes
d’d e o N = S \ 4' 1 ﬂ' @ aa
nidnvazmamaulagudaginaaziinedesquidsuswasidwuilu dygruaiaea
@ ] U - < a @ 1
Tuiuii hidesdseen llauniioudda uienfedusavziicesulasdyanaudslundas
Anralae 83U CCD Msuuaenziundintuded uazszdenin ldoenualieesnlindin
[ a ° v o <
wlasdygradniidodndssdueado nulries anuieudr smdganalass 1995aa
9 o
Noise a9 lluwanaes
nanaa Ie meeziinsSudadagnanmuasidosTaslsamd 1.2 GHz vie 2.4
¥V v
GHz luszoz L 100 was Tumswannszvudumifilszaudnivezaanindesinle13me
Y 1 o w s a i ] Ao
Pinuoua Taondanuesaindesinale lfawnnnuuameivuia 9 1had daundavesd
AURNITIFOUABIINUAISUT YR I (Receiver) - TABNAINUVDIAITUAYYIUNININ
~ d @ ' @ ~ £
puamesvuIa 12 Tad dedlvedndeslfmenaasasili 2.2 Fuilundesnuuduea
Uszreudiodindes1ime dsudyaa dunlasdgyeru numaeiving 9 Thad Taondes
e 1 d o o o 4 A o N @ e
unmudidenwindedddudyn s 4200100 1.2 GHz  Famiasussanidniudulag

A o Y o a
wanaierihdeyadigszuy TasgiluunveswanimiluTvua RGB vu1a 640x480 Watsa

ORI INTAININ (Frame Rate) 15 MNABUIN
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V

W-0o7

\_ & )

31 2.11 ndes SmonuuBued (http://www.tarad.com/simatelecom/img-lib/spd_2008021

5124028 b.jpg)

2.5 MEINANISVVAIYIDININAMIFTZUU
MINANITZVNUAWIIMINAIUITZ VU (System Development Life
- 3 o =a o @ o 9 @ o @ :
Cycle : SDLC) muﬂau‘lumimmmmti‘lumﬂu 'Vlﬂﬂﬂ'li wmmti‘]u'lﬂmumﬂmmﬁau

4 b4 v
Tagaaesmsnanszulisure UMM vInUa1AY 7 Yuaou asgii 2.12 1dun

2.5.1 MSANMIWIAINAGINS (Requirement)
& = ] =) lciy @ g 4' Y J
WolluNMIRTAUN TZUVNUABUNUADI NABINTIRAUNINTUAIT NIZWAIUITY
v oa v a ) Jo’:
wse'ly SudrensfnEInaundeIns Iauaeuwuaes ity daudlulld 1dnanalulad
A o Y o KoY v = 9 A ' o ¥ ¥
udmdeds dnihszvumandedsslinulinieli nazszunie: Ienniulianudguamg

ifsHgnINse i

2.5.2 MIIATICHIZUY (Analysis)
ﬂ 3 a 'S A Aq W ] a wa a
huduseuvesmsinsiziszunnuaunldaueg Anvinsifiicauvesssuau
o’:’ ] - A 9 ' o Hq Y 1A 9
nnvuneuBiNadea e linswhilymlumsiauvesszuuildegiios 151hs gilassa
uazanuiadesiioghlarhe uazadsud lvilfuilyeedals dumsfadhlassvesszuylutd
=~ o o U v vy yr oA v U v o
wlidnvazmannuedls dedldmidielumsduiumsming uazesldwailse Tomnd

¢ lsaoununy
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2.5.3 MIvdNUUVIZUY (Design)

v 1 ¥
% 1 U LY LY v 9
Yunounsn umsesnuuuszuuedianieg Tasszyiammiamuaiy dmlald
v
a v o Y ' @ ' 9
aeunames daulaldau mahausisaesdauzilszauiuedils wiideyaes lad 11y

seuUINe Hag seuIzNanes lseenuing

o’/‘ { ° v d °

‘uunauﬁam li‘]uﬂ'liﬂ'lﬁl'lﬂi'lﬂﬁzl?lﬂﬂﬁ'l@ 1 UBITSUUIUATUANYIU LFU NHUA
[ 4 v ~ ° 1 [y 3 o
dnpaizvaaeiuan q Nezihdeyaihgszuy dnvazmsmnuvesllsunsy fvua

9 Y] P ° v
wudoya uazgudeyanaziinnldau
q -
2.5.4 m3tveulsunsu (Coding)

v ¥
Huduseuvens Wou Tusunsulaoinidiou Tasunsy (Programmer) el anse
o o A o Yy ¥ v o4 Yy A A
MarvuazsesSuanudesnismundivualilalas  Aeudenldinsesiionas

a &t o 9 o
muneuiaaes nnzauniFlunmsiannlysunsu Wasuauysal
2.5.5 MINAABYZUY (Testing)

y ' o < = ol

din@ou Tlsunsuuazneasuuaaz Iilsunsuas wda Nezasai sunsunanuain
v ¥

saufuiluszuvauIng tasnagensmiudnasy uennnuuduilunisnageunm sy

[ o @ 4 Qo ° [ w 4
VOITTUUTMAUN VY HIAIY W31 zunnnszuuwﬂw’{mﬁﬂumamﬂuﬂmﬂ%’mmna
4 ° Pt A ' & N Zes Aq ¥ - '
vunssTlsunsuhen 18divon udszuudumaniu inligumquisinaunldauiniu i

@ @ d ] r @ a = o
duwusuaz limusolszeuiu ldanuanun ldaeumauaes i
= :l v
2.5.6 AANIIZUVNUINA (Install)

& ] 9 9 =1 -~ a 3 ] =
wamﬁauszmjwuu%"lummqnﬂmum ﬂll'li\ﬂﬂ'lﬁﬂﬂﬁ\‘ii%'ﬂ'ﬂ1141]!1?13!‘1]?1014
° =y ] 2 v v o
szmsmqm11mszuumumxﬂuszumm‘lﬁn mmumm:'lumw%'eu nmum:“l%’

b 4
RAMUIUNIN VNINTTUAN ) A9

a ) a ¥
e Wougilessuemsldnuszuy
v o d o @ v
o Fahwwunesua q dmiuszunin
o dafneusuffiaeu Wianud s luszuunazaunsaldanld

o nlasudeyaduniiogfannsaldldnuszunlni
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2.5.7 M3111§350¥152VY (Maintenance)

o’: Y [ W Y - @
Wuduasuniaos  quadaw Wssuuawisonsegld  saulddemsyivilye

v v ¥ :: °
wlasuulasunediunsenanyavesszuuie Idmunzay uaz sz vuanmiveusain

anudesmsvesd ¥ lduniiga Wuanuszezen

Requirement _l

.

gﬂﬁ 2.12 HEAA9239IMINAMITZUY (hitp:/Awww. Icct.ac. th/office/home_

el/book/sdlc.ppt)

aa P o
2.6 a1ndaessIn (Java Media Framework)
Java Media Framework “(UMF) 1iluia3esilodmSminauedeyaluziunuves
w o a 3 o v o a ‘s 3
Wadlify (Multimedia) 1 1¥mansaldnninauedoyadoiadaiife 1daseiu Taeld
siumsiuauendis Window Media Player ¥83 TuInsasown (Microsoft) @ JMF iiluuiin
g Ay gy v v o & v o o a o A
el ldsweglugaves 12SE Aiudedesn1nd Ivan IMF uaziin1sAanIaduumie
a d v < 9y 9 o 9 o < o o
Aounanesnoudsza e 199wl Pegiu IMF Tawannunienesdu 2.1.1¢ Taoanse
" 4 4 a 3
a1y Inaa IMF 111991189 http:/java.sun.com/products/java-media/jmf aL1iioAAAI IMF
a ) a o . ) A 9 9 o A oA ] A a Y]
AIVUABUNAADIUAIVTUNAING “Javax.media” T nSounumniostioduseginGon 1%
97U JMStudio 1Ad18M3AANIEBNILY Start -> Programs -> Java Media Framework 2.1.1¢ ->

y £
IMStudio 921/510 90 MYBIMStudio ieillaT1l51n5u IMStudio ¥uauda aunsadla’lWa
@139 18
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' o 4 o [ '

i IMStudio vzannsatiunlFnumeuaas Ilddszinnaeg 18 uadwlsouiion
AuNMYDINN tazidosdumsuaniie TisunsudIduq (1¥u Winamp %59 Window Media
Player) 482 IMStudio Salgaunmussnw uazidosinisunsuduediuiiuldda

v 9 ¥

IMF fidadsnsuuinisandaunsainauiy Ididosaz 3 o lanawgiuuy i
AIFF (.aiff), AVI (.avi), GSM (.gsm), HotMedia (.mvr), MIDI (.mid), MPEG-1 Video (.mpg),
MPEG Layer II Audio (.mp2), QuickTime (.mov), Sun Audio (.au) itag Wave (.wav) iludy ua

A a I’l‘ [ " o . °
iloRadaud IMF vzdia liaiumyu IWd MPEG-2 Layer 3 Audio #30 MP3 14 dhdosmiai
s MP3 1199y IMF 92de3a121! Inaa Plugin ¥89 IMF #5001 “IMF MP3 Plugin”

o a : a d A 1 =< 4 o 9 d
uazihAsfILUABNNINBS IHENEY IMF azanniamulia Mp3 14 Tasauisoanau
Tnan'ldn http://java.sun.com/products/java-media/jmf/mp3/download.html
A a g a d 9 =4 < . & Yo [

(HioAnfa IMF  aquunsunaneindd 921 1nQunning javaxmedia ¥ 1¥dmiy
sanmstunmuazides Taouinmneseanan ldsausauamanazununedug dl¥dmiuianms
Y a 9 ﬂ ° ¥ AR, R a
funmuazides Bidusiwaunnn ualuiniieena170uamig Class, Method 1ag Interface N19¢

=] 4 :
Moluunne javax.media vy
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ﬁmaqanmzmniufaﬁmwauma NITRANINAINIANITIN

unn 3

d
N5 ANITHUAZDBNUVUISUY

3.1 ANUABINIFVBIIZVY (Requirement)

o A

° [ o a wva @ [ 9 @
TumsiunaTuTaduoudunliandhndssdounuuyudimeslomasiilseause
v awa n’: A d @ o o
nnmamsaiieAiad1eg Wi luannznedeniiusudsiomdedilszauininuesiida
a da 1 o o s v
wlsnameriiaitimanemanauveusumen iFlumsdumdilszaudie u anudou idos
@ @ w v o [ o o
an$nsinie uazuaeang udu maldsuaesifivsdaufenlunmsfumiilszauio 19
° 1 14 a a 4 Jd g o
Imsduniinldeds Lifidszaniam psnnmueiudasdiannsamanldluanig
9 do o ] o = v Y ¥ Aa q Y v @ @
wAdeun$ia 1y e Iagamgll aunsanswIVFlszaussnaaeylammliminie
8 ugnsunau 1dhsnnamuieuresannznadeuneuenniennunasiuiianiiou
[ a, P @ o
dundes3a 10 (Video Camera) Wiy Ifdoyanamonmyesdi)szause ud higmnse
v g v WY Ada v " A A o < & aa
fumilszauio A luamunindiuasaie lidivane nieliduaiumniu aunslunsdi

o S

Alszauivanegldannusminie dudu
v
v @ o v U 4 g '
gainluszyudumdiszaude Jaldmsomdeyanimaumes 3 @1 ldun
5% @ v a o a Yy aa 4 o 9 =
iruires aseRuANUANTBS a3 Iagamyil uazndeaia le 1¥me wazideyainldnn
do A v o A ¥
o3 Aanaulszananaiedumfilszaudy sannsaaglifuanudesmsvesszuy

v
@aaii

3.1.1 anudeamintiluyiN1anves3zuY (Functional Requirement)

- szuudesamnIndanazudasiiveyaveuies gungl waznmla

9 a ] o
szuudesaunsonsndeuidvaazgungindnlszananaiuiludilszausiold
¥ @ 2 3 = a 9
- szuudesaunsmiuiindoyaidos guvgil uaznmld
- szuvdssannsasamsiuniwlasmsasnindvesn 18
9 o Y a
- STUURBIEININNNS DHYANIIATINIIITES gangll uaznw i

Vv = 9 wa = a 9
- szuvdesdnnsnisongleyaisz iaveudios gungil uaznnld

06000
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3.1.2 ANuasIn1sN lilyminNvea3zuy (Non-Functional Requirement)
- szunezded hiswvazilfiinam

- 52UURRIEINITINUT AT ULAUANYBIUBUA |4

9 = 9 ] do o Y 9 ~ o
- szuvdesmusauanilasudeyavinyusudsudedaiugulduuuisealngd

Q

(Real Time) ¥301321%123 (Dealy) Houiqa

d
3.2 MSAATIZHIZUY
@ o a Jd d o
‘ﬂ'lﬂﬂ')'lilél‘ﬂﬂﬂ'li‘"ﬁﬂﬂJﬂQiZ'ﬂ‘U?ﬂlﬂiﬂu11!'1')!?15'lz'ﬂﬂ'J'lllﬁal’f]\iﬂ'lillﬁzﬂﬂﬂ‘lfUﬂ'ﬁ

o 14 9 @ A [ ;
NNAIUUBIFSUY 'lﬂTﬂﬂﬁl‘lﬂI.Nuﬂ'l‘wgﬂtﬂﬁﬁw‘lﬂ'li'lﬂﬂ 3.1 AU

3.2.1 uwwumngaiaa (Use Case Diagram)

4 o o
ﬂ]‘ﬂﬁﬁ 31 llﬁﬂﬂﬂ'l'lﬂé’ﬂﬂﬂ'lillﬁz‘ﬂﬁﬂ‘lf\\lﬂ'ﬁﬁ'lﬂ']u‘\lﬂ\ﬁ2‘;'1]'1]

AMUABINITVDIIZUL gAAANI 95 UM NN HonIADS

1. STUVABITINNIOIANASHAAIAT

. L ) - " Capture Sound Data
5$ﬂﬂﬂ311lﬂﬂ1lﬂﬂlﬂﬂﬂ1ﬂ o, \W ~ 17 11447 SoundSensor

2. 53‘1]1]631'8\1’(111113O’S’ﬂlm&lﬂﬂw‘lﬁ'l

* Capture Temperature Data "
= TemperatureSensor

uunil 18

Q U

9y v
3. 53”Uﬁﬁ]ﬁﬁ1ﬂ1iﬂﬂi?i}ﬂﬂﬂﬂlﬂ§a
Detect Victims

=y = Y 1 S
@oanazgurgiuadlsswaanan | T e

dhdalszausonseola

4. szuUAvITINITONAAIDYy Ao )
Display Data as Graph

wazgungl lugduuunslidu’la Operator

9 )
5. STUVABININITOATIVIUMN 1A

Capture Image Data
extension points
i ike 45 20om im0 i o1

WirelessCamera
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1 3 [y o8
mnw’fmmwmszuu (n9) gﬂlﬂﬁﬁiﬂﬁﬂﬂ'ﬁﬁ“’m LUIAIADT (AD)
(#i0)
9 L ] ~
6. ITUUABNNTIVUIIOUUNANTINN ' ! ™
Snap Shot —f
v v
ﬁENﬂ’li‘lﬂ Operator
b4 [ [ . - . )
7. FUVUADNNATINITOIANITIAUNIN Foom Snagati FO 2
Tasmsaamwdvesn 18 ——— operator
8. STUUABIANNTONNHIDHYANIS —
- = . _ Stop Capture Data
AT QUURN uazn N 1A Nohllk, - Operator
Pause Capture Data
Y o =2 9 a2
9. I¥VUADNTINITOUUNNVDUALTYS WU AT N s
1 ( Manage Data File
qaungil wazn w14 i S B Operator
‘Save Iage to File T
Y =) iyt
10. Szﬂﬂﬁﬂﬂﬁ'lu"ﬁﬂliﬂﬂﬂ‘ﬁ'ﬂqﬁ o AT iy
)\ © Show Historical Data -
sz iAveudonz guugil 18 i Operator

MNANURBIMINANYBZUVaNNsainnImswtasiraue lugduuuuwunw

gounar'lAvLUnTY (Use case Diagram) 18@s31ii 3.1
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Victim Discovering System

Capture Sound Data

SoundSensor
Capture Sound and Temperature

extension pomts
e t M € awture data
Capture Temperature Data

TemperatureSensor

to puase capture data Detect Victims

tUsef would like to stép and clear the data Save limage to File
Pause Capture Data i

Stop Capture Data

Capture Image Data

extension points

Operator WirelessCamera

Show Historical Data -

Snap Shot
Display Data as Graph

Tiser woulthke,to 7d0Mumags

Zoom Image I/ Out.
Manage Data File Ere 156 BaAse ; R

g1l 3.1 namamun MgaaTMINs s UBAUTIRL ST DAY

uwunTWyERTae31A 3.1 wemsliiiums S msif (Functional) iozuenines
(Actor) 1 1&aBY (Interact) fuszuufumfilszauss Tasiuwunmgamaveniiuununn
devnivluiteuanssioazdoanioluvesszuy Idedadamy nazaainnuanuduiusi
Fudouns Tasununmgaamvesszuudumidilss auinlszaeudogamaauazuenned
fadelli]

1. gaunansiudeyaiduaazguugil (Capture Sound and Temperature) 1ilugaine
wiiaFaniiil (Functional User Case) Tﬁagmﬂﬁf;nzﬁnmﬁu‘i‘ﬁmmﬁumsﬁwmgamﬂ
asudoyaides uazasndudeyagurgi

2. yeunaAsITUOYAIAY (Capture Sound  Data) iiugmaarsiiaFanihil finvhil
asIUsTRUA IR B dswAzARGoiuemme AT o

3. gannaasaniudoyagumgil (Capture Temperature Data) 1ugamaawiiaFaniii

9 [ as S @ a
ﬁ"u1ﬁﬂ5'J‘)ﬂU53ﬂ1|ﬂ']11]%’ﬂuﬁ’]ﬂuﬂﬂlﬁﬂsﬁ')sﬂqm"ﬂn

a a9

4. gennaasvaoufilszauns (Detect Victims) ifluganasiiaFanyii finth

=h.

asnasudeyaidsaazgamgiiudnlszananainiudiszausonseli
5. genAaAs 293 uTOYANIN (Capture Image Data) iluganasiiaFaniing v
v Y o o 9 :I’ o 3 v
asvdudeyanmuinuenmesginsaldsuniwuunSme Tasgmaaiivziuduisdes
a o @ R y
pfomsvesgmaaiuiinnwiiuuiudeyagiam

6. gamaiuiinamiuufudoyazinn (Save Image to File) ilugmaawiiaia

Y A a Y Aw v 2 g o o 1 4
HUM ﬂﬂu’lﬂiﬂllﬁzﬂuﬂﬂﬁlﬂuﬁﬂ’]ﬂQ‘lﬂllﬂﬂlﬂﬂiQﬂﬂiﬂ(ﬂ?iﬂﬂ’]ﬂllﬂﬂ‘i?ﬂﬂ
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7. yenaaaiuina s aduuiludeyazinm (Snap shot ilugmaasiiaFaniir i

v 2 9

winntiufindoyanm
= ¥ a A Y A g o
8. gaiAa@AIn /00N (Zoom Image In/Out) iilugaAawiaFaniin Inihndanm
v
Wh/een
9. gaaeRAMIATINTIADAZUNYT (Pause Capture Data) 1iugaAdyiiAITs
Y aa 9 A @ 9 a Y] ao
wihh fivihivganisasisdudeyaidoaazdeyagungizIngg
10.gouAANYANIATINTUIFDAT QU (Stop Capture Data) iiluganaayilaid
gy da 94 @ 9 a ¥ a
wini indhinganisasaedudeyadoaazdoyagungil
11 gaunauaadoyalsz IAveudvauazquugil (Show Historical Data) tHugenae
siiaFanTi Inihiuaasdoyadouasgumniideunds
12. gaauaasteyadonsw (Display Data as graph) ilugenaau1sssu (Abstract
A o) L ) = L
use case) Hlgamaadevagnielu Tavawiiogvazdealdvninurunmgmaadosuans
Joyadions
. 4
13.gaunmian1suiudoya (Manage Data File) Wluganauinsssy Famnsog

swazidea laluumunmymaadosiamsududeyadoya

Lmumwgmﬂfmmszuuf’\'u111Q’ﬂizﬂuﬁuﬂszﬂauﬁauuanmas'ﬁwiﬂ'lﬂif

14. uenuaes fUFiAns Operator) iHunypin IFszvudumiilszause

15. UBAABIAISUIAYI (Sound Sensor) Iugilnsaldedoyadoudrigszuudum
Juszausie

16. uBMABSAITURUNYII (Temperature Sensor) 1iluginsaidsdoyagungiiihg
szuudumdilszause

17801903525 uA MDY 1500 (Wireless  Camera) 1iluginsaidedoyanimdig

szuudumdilsyause

3.2.1.1 HUMINgaIAEBBIaAIYeYan 8N W
t 4
Uszneudogananne 1l
1. ganauaaInsMgungll (Show Temperature Graph) iilugaaayiiaiFamiin i

wihnuaasdeyaguugiilveglugluuvvesnsidy

t=4)}

2. gonauaansMidos (Show Sound Graph) luganasiiaFaniin invhi

wihnuaasdeyadoalieg lugluuvvesnsiidu
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' 9 9 él Jd A d9y
umamwgmﬂﬂtjammﬂwaganwnsMﬂsznan AWUDNIADIT AD LBNIADIN

a wa o @ @ .
1I§1i@n3 (Operator) unnudmdh IdszuuAumiilszauds dagalin 3.2

=z=guhsystem==
Display Data as Graph

Show Temperature Graph

Operator

Show Sound Graph

51 3.2 uaawwunIngaaddannaaItoyaden W

3.2.1.2 uwummganasesdansuruteya
v
szneudisgmaanne 11

1. gapanladoyaninuitudoya (Open Data Form Text File) iilugaaasiia@aniii

a Y oA ) a A
UNU'I‘VIU'I‘U?]QE’IEZ'TUQ Qﬂl'ﬂﬂ” uaz;ﬂmwmﬂu‘ﬂuﬂagamuﬁmna

2. genaatiuiinufludoyaiihy (Save As Data to Text File) ) silugmnasiindamim

o 2 o

¥y A Y] a a A 3y ° ' Y] ~
HUIMN uﬂﬂ‘uﬂyﬂmmtmzqmﬂ Qllﬁ1”%ﬂllﬁu“ﬂ¥aua$ﬂ“l"u\jﬂﬂqu'ﬁuﬂﬂgﬁ"uaﬂlﬁﬂi

e XD

Ugiiamsimua

3. genaafuiinududoyn (Save Data to Text File) iihugmanaiiaFanihii indhil
tiufindeyaidoainzgaugiviasivoniudoyanazdumisvewdludoyaiidlaldnuogly
iy

ununmgmaadessansuiludeyalseneudloneniaes Ao uenwmesdifiAMs

ot @ o {
(Operator) Hunyudidn 14 eunfumdilszauio dagain 3.3

<<subsystem>>
Manage Data File

Open Data From
TextFile

Operator

Save As Data to TextFile

Save Data to TextFile

31N 33 nanuwunmgmnadesiamsurudeya
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3.2.2 Mmesiegman (Use Case Description)

MmN 3.2 Mednogandasieiudeyaifvanzgungil

Use Case Name: ﬂ‘sa%%’u%gmﬁmsmzqmﬁgﬁ ID: 1 Importance Level: High

L

Primary Actor: éﬂﬁffami Use Case Type: Function

Stakeholders and Interests: 'liji'l

. .. 9 1o ° A T YA wa o af 1 ¢ A 1o wey
Brief Descnptxon: Pjﬂ{]nﬂmiﬂmﬁl‘b’ﬂuﬁi)‘qu‘n‘ﬁizﬂ'J‘Imﬂg‘ljﬁﬂﬁﬂuﬂﬂﬂuﬂuﬁ lWﬂﬁQﬂTﬁQIﬂ

oo o ad 1 Y 1 g o
gnsalSuidsaazdrsugangiined lutljuouam

Pre-Condition: szuufumiilszausogniaSouioouda

Post-Condition: Taidi

. g (o e U A v
Trigger: QUiANINALjuTBNABLYYD

Relationships:

o a wa
Association: 1tontAB3RUHITAN S

“

Include: grinedudoyaiFssazygmnadudeyaguugl

Extends: gainainn1ssudeyn uazgmaauganisiudoyn

Normal Flow of Events:
1. ffiamsdsmdadumsiveudeugys hidilafuous
o & 1 o a CEA-! Y 1 J
2. szumhnsdeudsugysiuiuglnsaiiufeunsgungideueud
A A T o o [ 9 o wa YY 1a wa t o o
3. disdeudedulsszuvezegluaamznionlfinnts uazeyanaldgufianisdeiia
susudeyadulsyauss
4. fufiiamsdshdasusudeyadilszausy
5. szuuGuasiudeyidse SwazBvalugmaasaeiudeyado

6. szuuGuAsviudeyagungll wazdes luganaaseiudeyagungi

Sub flow:

Alternate/Exceptional Flows:
A 1 A |- =
2.a iWeureugysiufugUnssifudes uazmie gumgiiduman
2.a.1 szupszegludaus hindoudfiiams uas Wieygna i iiamsdeidaSuiudeya

Jilszausie
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Use Case Name: A5293ud0yaifieq

ID:2

Importance Level: High

Primary Actor: A5 LIHYS

Use Case Type: Function

Stakeholders and Interests: "lﬁﬁ

Brief Description: tiledsmdalifsudoainu miudvesziuszdunnudsveudswdadawn

e giians

Pre-Condition: filfjiiAmsfidasusudeyafilszausuvSeuieouda

Post-Condition: 'lﬁfl

Trigger: fiamsnatjuisumsdudeyadilszavse

Relationships:

dao o
Association: {BAABIAITUITES

Normal Flow of Events:

1. szuudssamdslunmsoudeyados

1 o @ 19 @ & A A 19 e 1 o
szuuditdesudeyanndi uiseneg lullaueua

2

PRy v d o T P o a 9 A Y ' A 1]
3. wﬂwmuuﬂum‘mmmi'mﬁﬂn’nuuﬂumﬂaaumﬂu11mmanawmagma'lu
4

Avjuoud hilimsmasufimunimvisnsends MsufvaeziniasedussAuaNNas

A Ada 4 a o
ﬂﬂﬂlﬁﬂﬁﬁlﬂﬂﬂlﬂiﬂﬂ"]ﬂinﬂluu

5. MsuiesdetoyaszAununIvoudosndaundsssuy

6. sTuLNAAITBYIITARNNANBATuIN U B ST Ui ugIGTAN S

Sub flow:

Alternate/Exceptional Flows:
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a

Use Case Name: A3 ’Jﬁ]ﬁ"u‘ﬁ'ﬂu“ﬁqmﬂgﬁ ID: 3 Importance Level: High

Primary Actor: @ a%'nqmﬂgﬁ Use Case Type: Function

Stakeholders and Interests: Y2

Brief Description: tindsmidali@sugamgiinn disugungissiuszaunuiouudadwa

nderegfiians

Pre-Condition: iiidmsidasuivdeyadiszauivseuieouds

Post-Condition: "hjfl

Trigger: Ufjiamsnatjusunsiudeyadiszauis

Relationships:

do o =
Association: LUDAADIAITUYUNHUY

Normal Flow of Events:

AW

ruudasvamdalumsedeyagungi

=)

szundehdesudeyanndasugamngl

oglutlauoud

Ao ] I'4 ° v o d' o A 9 A LY 1 A ]
nweusua sTUhMIassaeuTusuAndeuau M o0 aundegns e la
fjuoua hifimandeufiduniimiensonds Msugungiiwinsasiefuseduany
9/ A a ¢g @ 3 A b o 9 o @ AQ’: ¥ oy
founifinvussuausnaniy dsdeyai lavindsugamgiiiusziiudeyady
drsvguugiidideynszaugamglinduindeszuy

o ; 4 Y 1 ' a
szviimsuilasdeyalvegluninsvesesaradua

szvunaasdeyaszAugunginududoysseunudliiams

Sub flow:

Alternate/Exceptional Flows:
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M3 3.5 Metinsyanaasvaeuseauss

Use Case Name: ﬂi?%ﬁﬂuﬁﬂizﬁuﬁ'ﬂ ID:4 | Importance Level: High

Primary Actor: Asuidouazaas quﬂqﬁ Use Case Type: Function

Stakeholders and Interests: Yaifd

. . e & 9/ o = =
Brief Description: 1/szuianafieniflssaussoindeymfvainzgungi

Pre-Condition: §UfjiAnsfmdssuiudeyailszausuSsuioondy

Post-Condition: llliidl

Trigger: fUfiAmsnatuSumssudeyadiszauss

Relationships:
do w A
Association: 1DAINDIAITULTYI

uenres AT uguINngli

Normal Flow of Events:
1. srumideynszruanududoanasisseufumarninziiveudodsaves
flsgausiy
2. ssumhdeyannuisunnnasivasudumarnihsyiiuuesgungiissnoves
Auszausy
3. fdeynidsunzgungiogiuton it mun ssuussudufeuhmuduszauseiu

dauaoszausudufiams

Sub flow:

Alternate/Exceptional Flows:
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m3197 3.6 MeBogandasiudeyaniw

Use Case Name: 13 n%’ui’fﬂgamw ID:4 | Importance Level: High

Primary Actor: @23 uamuuy13ae Use Case Type: Function

Stakeholders and Interests: 'hjﬁ

a ey q T o ] 1 1 L4
Brief Description: ulfjiiAnsademsiFoudedgyanumuniedouaulia szninglnsal

1w { y a wa @ @ { y 1 4
Sudsdgapaiegluidifidmstudiuamiimoieglurhveniusua

4 1w oo ' ]
Pre-Condition: i¥ousafugilnsalunmrnunieviouay l¥meoSeudoouds

Post-Condition: vhjﬁ

. Y (& wa U a o 9
Trigger: QURUAMINATUTUMIVLVOYAA W

Relationships:

o9 sy

S o =
Association: uaﬂmaimmmmmuﬁ'ﬁw llﬁzllﬂﬂmﬂﬂﬂﬂg‘ﬂﬂﬂ'ﬁ

Normal Flow of Events:
1. fufiamsdasidauiusudeyanm
g/ A v o 1 A g v S [ y
2. szunadumsieudedaanarnunienouay 15me seniginsalsudedygialuile
a aa v @ @ v ' L4
guganmsnudafuam Bmelufluesuoua
3. szundsiidsgmdeyanmondasunm o huilsjuoud
[ - b4 A v 1 o 1 1Y
4. @funmFmonegluihvesueudesdinmndessuu
v Q2 9 a o = @ &
5. szvutiviindeyanimlussunasuiiunes gsreazidoalugamaiuiinaiwiy
uiudeyagilnm

6. szvundasdeyan i uAesTeufuliians

Sub flow:

Alternate/Exceptional Flows:
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maain 3.7 fesuesganaiuinnmiduuiudeyagilnm

Use Case Name: tuinamidhuufudoyagiam ID:5 | Importance Level: High

Primary Actor: dsuamuuy ¥ Use Case Type: Function

Stakeholders and Interests: "lu'ﬁ

F 4 []
Brief Description: szvutiufinamitsuaauiudeyaiidmua

4 T r o o 1) )
Pre-Condition: (¥ouaefugUnsaisusmrnunsediouan Bmesvuioouda

Post-Condition: "liiﬁ

. Y (a e U =§ o 9
Trigger: fUfiansnatfuisumstudeyann

Relationships: T

Normal Flow of Events:

[
o

T 9 Y e‘ o Pt s a =y o Aaa =1 = L4
1. szuusmdeyadui wou I ¥aTue wifl SuuaziadIufvesszuunouunes uas
d‘ 1 ] ar
Wouaoilumesnuse
o LY o 4 % A~ q’: & < L)
2. szuuhmstuninnmlulasnmes C/PicVictims Tagsadie TWasnnmednuszlude 1

3. szuvaundulibhiden 1 nu

Sub flow:

3.a szvumgaunay lihided 1 diedufiianisnganmisasiedudeyanin

Alternate/Exceptional Flows:
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y o - o d
3l 3.8 mefinsgammiufinn S alluudndeyaginm

Use Case Name: ﬁ'uﬁﬂn1w1§mi‘luuﬁui’1’ega§ﬂﬂ1w ID: 6 | Importance Level: High

Primary Actor: asunmuuy1ee Use Case Type: Function

Stakeholders and Interests: "lu'ﬁ'

. . e o 2 P a e 3/ 9 Ao
Brief Description: szvutiufinamifuiiansdssmsawdudeoyandimua

% v o (47 ] ]
Pre-Condition: t¥eupfuguasaitunmmunssviouau 13musvuioouds

Post-Condition: "lliﬁ

. 9 (A aa W oo 9 <
Trigger: gﬂgmmsﬂﬂﬂmmay‘amwm

Relationships: 1ufi

Normal Flow of Events:
Y | wa U o
1. QUgianmsnaljududeyaning?
[ 9 v A A oy @ g A =t a an =3 = o
2. szuvusmdeyaiui ey 1 ¥2lue win JurnuazlinndunussssuunsuNAABT (A
Woudolumednuse
o o -1 3 n’a’ q d o
3. szyumnmstiunnnmlulaSnmes c//videos Tavaade Idanaesnuszlude 1 uas

suasilavowduily PG

Sub flow:

Alternate/Exceptional Flows:
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a19191l 3.9 Medugamananid/een

Use Case Name: #snid/o0n ID: 7 | Importance Level: High

Primary Actor: a3 uamuuy15ae Use Case Type: Function

Stakeholders and Interests: aidi

. . . ° 2 Y ¥ Y (A wa
Brief Description: 531)'1]1’I'Iﬂ'|5ﬂi‘lﬂ'th‘ll'l/ﬂﬂﬂﬂ']ilﬂ'J'lﬂJﬂﬂ\'iﬂ'li‘llﬂQE‘HJ;]Uﬂﬂ'li

" A (- o o t A y <4 y 14
Pre-Condition: umnmﬂuqﬂﬂimwnmmmﬂ5811wuau"lsmmwusauua’a

Post-Condition: vhl'ﬁ

Trigger: filfiiamsnatjudsnmdvenn

Relationships: Pty

Normal Flow of Events:
o wa L o ﬂ" % 1 l&’
1. fufidamsdemdanmwduiledesnisgnimiivinalnagvuy
4
2. STUVVBVHIAVBINMNNIATUANAAZIIBBAAIUAZING A
o/ -3 ‘F o
3. gfiansdeideanmesniliodesmsgnmniivuiamnas
E 4
4. sTuUAAvUIAvTEIMIWIA MR NeazE A UaTINg AU

a wa v o @ < g =
5. gUfiamsdsfdGigaiiodosms Idamuaasluviialnd

Sub flow:

Alternate/Exceptional Flows:

9 (e wa I\ o @ 1 Pw o Q’:H‘lon’l
3.a fiiansennsademidsdsnmesn ldfsonimSanhdudnunsiidesidedenind
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@13197 3.10 Meinegmaainmsiudoyaiduaagungll

Use Case Name: ﬁﬂﬂ”li‘ﬁ"ﬂ‘l’l’ﬂgmﬁ muazqmngﬁ ID: 8 | Importance Level: High

Primary Actor: éﬂﬁﬁﬁ 13 Use Case Type: Function

Stakeholders and Interests: 1ﬁﬁ

Brief Description: (lefifilamsnnaijusiinnssudeyaifsauazgungil s2UUMgANITAIINTY

Hoyafvaaz doyagamgiidngid

=9

Pre-Condition: §UiiamsnajuGumssudeyafvaunzgungi

LN

Post-Condition: vhJ'ﬁ

Trigger: fUfiansnatjuinasdudeyaifvunzgungl

Relationships: 1aidi

Normal Flow of Events:

-

1. fufiamsdemdainmsSudeyadvunsgungil

g o o ar - o
2. szuUMgaLEateyanIngUnsalsuissazfs Uit

a L)

szuveyanalddifianmsautiumsdudeyafsunzgungiine

9 «

w

Y (A v ! o ¥ o A s a
4, Ejljt;]'ﬂﬁﬂ']ifNﬂ'l’c’(s‘lﬁ'll.uuﬂ'lii]‘mﬁﬂﬂlm:’,qmﬁﬂllﬂﬂ

<«

5. szuusuasiudeyaisunzgungil swazdoalugmndasaeiudeyadoas

vl

Sub flow:

Alternate/Exceptional Flows:
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=Y

3190 3.11 MeF1nsymAaryansAs 19 ITELAZ RN

o

Use Case Name: #gan15as299uideauasgunsil ID:9 | Importance Level: High

Primary Actor: é’ﬂﬁﬁﬁmi Use Case Type: Function

Stakeholders and Interests: 'hjfl

. PR A 9 |awa U o 9 =) ) @
Brief Description: (1IafUfiiAMsNALumgamsiuvoyioinasomungil sTUUNYANIIATINNL

v =) s ~
doyaidouinzdoyngungil

Pre-Condition: §Ufiiamsnatjuisumssudeyadulseaudy

Post-Condition: 11iﬁ

Trigger: fifiamsnatjungamssudeyaidonzgungll

Relationships: Pty

Normal Flow of Events:
1. QUfiamsdemdangamsudeya
Ly 1 das o o =
2. szuungasumsdetoyaningunssiiuifvauazdaiugungl

YY 1a wa Q' 9 L] Q'l Qr = o= ]
3. szuveygna i iamsFududiiidnsrdudesazgamgiilvg

Sub flow:

Alternate/Exceptional Flows:
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My 3.12 Mefuneganduaasdsyalss Aveadoaunsgungil

Use Case Name: uﬁmi’fagaﬂiziﬁmmLﬁmuazqmﬂgﬁ ID: 10 | Importance Level: High

Primary Actor: Fﬁﬂﬁﬁaﬂ’li Use Case Type: Function

Stakeholders and Interests: 1ﬁ§

3
b4

[ v
Brief Description: seuuuansdeymidvwargamgidoundiduadssuuGminuaunseig

Ufiamsnatjuindeyadanin

Pre-Condition: fiiansdemdaindeyading

Post-Condition: vhl'fl

a wa 4 d ¢ A (Y
Trigger: flfiamsidoudlasinsinedougdoyadounds

Relationships:

o a o
Association: (eAWBIRHTAMS

Normal Flow of Events:

1. ffianmsidengdoyailszidveuivanzgamgiindenis

9
o o [} 9 wed'sl a e P |
2. szuusINdwrUsvesdyallssianglfianisaen

9 a = ey Y o wa = (] (] J 9 1A wa
3. suuLEAsYRaIiswns UMYl e yanguiamsiaenrudiudelssaudlgians

Sub flow:

Alternate/Exceptional Flows:
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131N 3.13 AeBuneymAduTaIns Mgungll

Use Case Name: Ue/A3N5 wlqmﬂqﬁ ID: 11 | Importance Level: High

Primary Actor: F:i:ﬂf]ﬁami Use Case Type: Function

Stakeholders and Interests: 'lﬂﬁ

Brief Description: szumiiiszauanudoui ldnndrsugamgiivuansiugduvunsmlidu

Pre-Condition: t¥ouefudIugamgiimuugysiiouioouds

Post-Condition: Taid

Trigger: QUfamsnaijuSumsiudeyadiszavds

Relationships:

o a wa
Association: UBAIABSAURTANT

9

Normal Flow of Events:
1. Fufiamsidenuaansgungll
@ Y (Y d' Y T A kY
2. szuvSudeyasvauniwdeungnuasivedlumitsvesosnadoauin
3. STUVAUIUNINNA X1 Lazhna Y1 mmﬁ'aypszﬁ'umm%’aﬂu%’a 1 HasuaaIgn
yuduanlsyaugfiams
o 9 u d' 9 U ] =S o o
4. sz1Jm‘1111agaszﬂnﬂ'sm%’auﬂgﬂuﬂm‘lnag’lunma‘ummmwmqmﬁmnﬂ'lﬂ
5. sTuusImmEGe X 2uaziie Y2 nindeyaszauaiuieulude 3 uazuaasya
yuduaslszaufUianis
6. sTuuNAdMIFousTNINgA (X1,Y1) fiuga (X2,Y2)

7. dielideyaszauanudeoulnmidhn ssuuezaundulinden 1

Sub flow:

Alternate/Exceptional Flows:
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M13197 3.14 Medinsgmnauaans iies

Use Case Name: U@a3n31WIT09 ID: 12 | Importance Level: High

Primary Actor:é"ﬂ ﬁﬁ'ﬁms Use Case Type: Function

Stakeholders and Interests: Taidd

. . L. oo o [ . P o o 9
Brief Description: ssuhiiszauanududoi ldnndarsudsanuaasiugduuunsmidy

Pre-Condition: I¥eusefudsuidssiuugysioudeouda

Post-Condition: Vlﬁﬁ

Trigger: filfiamsnatuFumssudeyadilszauds

Relationships:

. . o a wa
Association: HeAAB3RUFTANTS

Normal Flow of Events:

1.

Aufiianmsdsnuaanivides

2. szuviudeyaszaunnussusudoudnn

3. sTUUAMOAIGR X1 uaghina Y1 vindeyaszauanudweadoslude 1 uas
uerasgauudIuavssaudfAnTs

4. szuvSudeyasziunnudsveududiada li

5. sTuuSIOUMIRNG X 2uaziing Y2 mindeyaszauadudeuieslude 3 uay
uermsyauudIuaolsyaufilgians

6. szummtﬁ'm‘f;emzﬂinqﬂ (X1,Y1) g (X2,Y2)

7. iefideyaszRunnudveadoelmidhun szuuszaunduliided 1

Sub flow:

Alternate/Exceptional Flows:
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ma1an 3.15 Mefusymaadadoyasinuiudeya

Use Case Name:nﬂm’fagainﬂuﬂu%uua ID: 13 | Importance Level: High

Primary Actor: é’ﬂﬁﬁﬁms Use Case Type: Function

Stakeholders and Interests: vln'ﬂ

. .. o ¥ a a 9 AY (awa )
Brief Descnptxon: 531]1]1“‘“8%?1!.?{{1\1 Qﬂlﬂi‘;\lﬂ uazg'ﬂmwmnuﬁwa@wgﬂgunmmmmim

UTHAINT

Pre-Condition: : fi/fjiamsihmsiiufindeyai lAnindasuidos driugangil uazdrfunmuuy

1w

Post-Condition: \lﬂﬁ

Trigger: fUftiAnsnatjuilauiudoyn

Relationships:

. . o a aa
Association: IR HURTTAMNT

Normal Flow of Events:
1. fufiansdedhidailedeyannuiudeya
g d a wa § 4 °
szuuuaas lnondonufenltfufiamsidensoseufludeyanidesnisiwuemas

Afiamadenuiludoyaidesnis

> w N

9 o o 1 o e 1 ]
Joyaiios gamgliuaznmunuiludeyassgminnuaaswasnfuigmsvudaude

dszenufalfians

Sub flow:

Alternate/Exceptional Flows:
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a ° a L] ¥
ma1an 3.16 Medugmaatiudinuiludeyaidiv

Use Case Name: ﬁuﬁnuﬁu{’fagmﬂu ID: 14 | Importance Level: High

Primary Actor:éﬂﬁﬁaﬂ”li Use Case Type: Function

Stakeholders and Interests: 'llifl

Brief Description: 35uu/hmsiufindeyad ldendasudes drsugungl uazdaiuamuuyls

Mo sonazdumuweswiudeyanfgianisdmua

Pre-Condition: Hgan 1593293 UIFBLAZYUNYUFINTT

Post-Condition: "lﬁﬁ

Trigger: fufianmsnatjutiuiinuiudoyaifiy

Relationships:

. . o a ea
Association: steane3 IR 1ANS

Normal Flow of Events:
1. fufiamsdefdaiuinududeyaiiu

o ° A s
szunuaas laodesliidondunisidesmsiuinuiudoya

Ay a R

2

Y o
3. fufiamsiden lasanesndesmsiuiinudludeyn vazdsoududoyn
4

szuuiufindoynluududoyany lasansiuazFeuiudoyandifidmsdmua

9y

Sub flow:

Alternate/Exceptional Flows:
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a1 3.17 Mefuegamaatiuiinududoya

Use Case Name:tiufinuniudoyn ID: 15 | Importance Level: High

Primary Actor:éﬂﬁ 1aN1s Use Case Type: Function

Stakeholders and Interests: 111?1

. « e o Y ﬂ s ~ @ @ o o a @ o 9
Brief Description: 53UU'VI’Iﬂ'IﬁJu‘Ilﬂ‘Uﬂ!gﬁVI1gﬂ1ﬂﬁ?5ﬂlﬂﬂq AP UPUNYU nmzmsnmmmu'li

a0 amFeuazdumisveuiudoyanidlaldauey

Pre-Condition: ¥igAN3AS19TUABAZYUNNTINGT?

Post-Condition: nln'ﬁ

Trigger: ffiansantfutiuftnufudoya

Relationships:

o a wa
Association: oRRD3JUHTAMS

Normal Flow of Events:
1. fiamsdetdaiunnududoye

2. szumivitndoyaluududeyamuieuas lasanesvewdndoyailaldaveg

Sub flow:

Alternate/Exceptional Flows:
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323 UNUMNNINTITH (Activity Diagram)

3231 UWHUMNDINTINATINVVVBYAITHIAZRUNYN

Opertor Victims Dicover System
Request - Create blue tooth
connect to conection to sensor
sensor ;
Start Capture = =

y : ééptute : Capture
Temperature Daﬁ_al Sound Data nl1

| Would you like to pause capture? ]
| |
| 1 \yes
| W/,
no‘; Y : Pause }
no ‘ Capture Datg“ ;
| -
|

i

AL _\1{ .

¥
-

Wiould you Iik7 to stop capture?
{

: Stop Capturew
Data .
m

6’.

31 3.4 uwunminssuaseTudeyaidsaazgung il

v 3 » . k4
vng1ln 3.4 QGiianmsdemdeademsisenaeugys lldwauoud simiuszuuee
o 2 1 v @ g v v ¢ A A ' <
Mnmsadumayeuaeugysiuiuginsaiiuidewazgungiidiuoud ieyeudeduie

szuvvzegluaniuzsniewilfiianis uazeyyralidifianisdemdusuivdoya

v
a wa 1 o @ A

9 LY Ay o 9 9 o A @ 9 =
Hlszaude weriianmsdemdusuiuveyadlszauie szUUIITUATINIVYBY AT B
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=

(Gwazidea luunumwianssuasniudeyaidoadagiil 3.5 uazisuasieiudeyagaungil

(wazdvaluumun i suasdudeyagumgil Az 3.6)

'
o g

Tusgnnnszunimsansvudeyaidvaasgungiiog Mdugiamademidainns
o = o o @ o a o
Tudoyaidoaazgamgil szuunganaasdoyannginsaiiudowazdiugumngiising
A Y Y (awva () o o 9 @ [ dar A
wioddifiiamsdamdanganisiudeya szuungaiumsdedoyaninginsaivudvaas

arsugungi

3.23.2 HHUMNDINIINATIVIUTRY AT

{ Victims Dicover System j Sound Sensor

| @

% | |

! send Sound set sound §

command S S0 —¢ommand 3

i

| ! E
5 |

i
read sound value .. return sound
value
t
|
|
A 31 0 LER NI @ BRI D' O |
Display on
screen

| "<

| [,

| (@)

31 3.5 uwun AN suATTUTeyaITe

1ngili 3.5 iWedifiianisirdasusudeyadilszause szuuszdesiamdalunis
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3.2.3.5 UHUMINNINTINATIVTUVOYAMN
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3.2.3.10 HNUATNDINITUREAN TN IVIVTLINA YN
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3.2.3.13 uHuMNAINIINMEAINTIIEes
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3.2.3.15 wwumwianssudufinuudeyariiv
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3.3 MIvdNNUUITUY

33.1 aa1alAdzuAIN (Class Diagram)
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332 dmnlaesunsu (Sequence Diagram)

33.2.1 Fnnlaezunsuns9duUeyanIn (Capture Image Data)
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3323 amlaezunsunaniwadeyalugiuuunsvlidy (Display Data as

Graph)
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33.2.4 Fmlaezunsumsdansuiludeya (Manage Data File)
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VUADUMIAANT LeJOS NXJ U Windows XP
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LEJOS o
Java for LEGO Mindstorms EmindsTorms

Home o, ¢ B g
Tt i b 2 ed N
LJOVV T $Rd 0N

API Win321eJ0S NXJ
PC APT
Tutorial Download Giig

Linux /Mac

iCommand
API Download Glick to downloag
Download Download Area at Sourceforge
RCX Brick
leJOS RCX Other releases, notes. dates and sizes are avalable at the SourceForge downlosd sres

Tutorial
Downloads
FAQ

Forum

Books

Links

Contact

TSR
et

java.net

Disclaimer: Java is a trademark of 3un Mictosystems. Lega Mindstarms is a trademark of the LEGO Group. There 1no assodiation
between Lego and ledO8 or Sun and le)OS, or aven between Lego and Sun as far a5 we know
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1eJOS NXJ Setup

S I e

Welcome to the Installammer Wizard for leJ0S
Wa

This will install [2JOS NXJ version 0.7 on your computer,

It is recommended that you dose all ather applications
before continuing.

Click Mext to continue or Cancel to exit Setup,

r A
UM A3 naaImsAana 130T LelOS NXJ

) 3 ° =) ~ @ . p ) a ¥
4. nniuazdumsdmualaianeinan(Root direstory) Maziimianddl1sunsy uan

AANTJU Next A93119 n.4

Setup will install 1eJOS NXJ in the following folder.

Toinstall to this folder, dick Next. To install to a different folder, click- Browse and select another
folder.

JOK version is 1.6.0_07

Destination Folder
C:\Program Files|le J05 NXJ

4 3 =] B o o a &
UM n.4 uanamsimualagnnesnannziimsaanilysunsy
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MINAUITZVY A93UN 0.5

Setup will install leJ0S NX1 projects in the following folder .

Toinstall to this folder, click Next. To install to a different folder, chick Brawse and select anather
|| folder.

The default folder is C:YJsersiLawrie {2 JOSNX Projects

Projects Folder
<%%Home% > YeJOSNX Projects

t:‘ o =Y g/

a o < ~ @
1 0.5 uamamshnua el nnesvaniazsiinisaens lsun sy

¥
o

Y o = a =)
6. 311U 115UNTUAARIIZIINITIEAITIBAZIDIANITAANIDNA

g
3

a v Y
1 11IN3WazIBuAYNADI 1Y

AANTJy Next #3317 0.6

| Start Copying Files
| Review settings before copying files

Setup has enough information to start copying the program files. If vouwant to review or
change any settings, dick Back. “if you are satisfied with the settings, click Next to begin copying
files.

1 lngtallolrectory e ———— I e iy
C:'\Program FilesjeJOS NX3

' Projects Directory:
1 C:\Users\Lawrie e JOSNX IProjects

Setup Type:
Typical

i v
31N 0.6 LaRLIWAZIBEANIIAAAY
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v ¥ q-
7. TdsunsuAanaziimsaans LeJOS NXJ aagii n.7

leJOS NXJ Sea.g

| Installing
Installing leJOS NXJ

Please wait while Setup installs leJO5 NXJ on your computer,

Installing Projects

' v ¥
31U 0.7 iaR 190 1A3RANT AAT LeJOS NXJ

A ald ] o a v @ =
8. Wemsaanaaavauysal llsunsuAaatszuaainizln n.g

Installlammer Wizard Complete

The Instalammer V/izard has successfully installed leJOS
X3, Click Finish to-exit the wizard,

When you click Firish, the firnvvare flash program titled
"Install NXJ Firmwvare in NXT" will run. Follow the
instructions on the screen and it will update the firmware
on vour MXT to ieJOS NxJ 0.7,

vhen you exit the firmware flash program, this setup
program will finish.

If the firmware flash program does not run, go to the bin
folder in your instaliation directory and run nxjflashg.bat.

a EY) a ¥ =] o
3UN n.8 uananthaemsAnA s VeIl
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weillaTusunsudimiuRaaailiunnivog LeloS NXJ A9g1i v.2

Fie Edt View Favortes Todls ‘Help

wm— 1cconsoleviewer bat . rdataviewer bat
b )

] rxflash bat s nxiflashg bat
‘iﬁ o 4y | MS-DOS Batch File
et L

| 1 flashainst bat ik bat
ods 3

ﬁmmo bat napccomm, bat
b 1 B v

Type: M5-DOS Bateh File
Date Modified: 11/11/2008 3:37 °M
Size: 270 bytes

nxjflashg.bat
MS-DOS Batch File

Date Modified: Tuesday,
November 11, 2008, 3:37
oM

UM w2 uaaslaisaneivoa 1a ¥o nxjflashg.bat
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Start program

Progress Log
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TunoUNMIUSUIAT Netbeans 1IN0 IF 113 INAY LeJOS NXJ

1. M3AAAI Netbeans
1.1 a9 naalilsunsu1dein http://www.netbeans.info/downloads/index.php ﬁ'ﬂg‘llﬁ

.l 511’97’ click ﬁﬂu Download NetBeans IDE kﬁﬂls'ﬂﬂ mirror site 14N15 download

Home Products i Plugins

Download NetBeans [DE

Other Systems & Lanquages

a ) 7 ~
sUn a1 uaasinelunisaini lvaa 1isunsy netbeans

A = ) Y | h [ ¥ o ¥
1.2 110 download 1@3 342 2% 10 1WA netbeans-5 5 “I-windows.cxe #71 IINUUAA A9
- -~ S0 (o S
11/511n51 NetBeans 5.5.1 Tag double click 11197 netbeans-5 5 1-windows.exe 1151053

t) 5% [ [ ~ ; ~ Ay Y vy
Installer LAAIVONITHADUTY AI3UN 7.2 click W Next 110 T nihan 1

f InetBeans IDE 5.5.1 Installer

| ;q,‘g‘ i

foriNegtBeans IDE

The Install Wizard will install NetBeans IDE 5 5 1 on your computer
To continue, choose Next

InstallShisid
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A . . ¥ . A v Y1 o
1.3 1890 I accept the terms in the license agreement 1407 click Next WD liniaeli A

|NetBeans IDE 5.5.1 Instafler

Please read the following license agreement carefully

NetBeans Version 551

Please review the complete list of open-source licenses
governing software included in this software They can he
found in the THIRDPARTYLICENSE b file

Please review the list of libranes and li s provided
for use and redistnbution by other parties These libraries
are redistributable subject to the conditions in the
DISTRIBUTION b file

This license file contains five distinct licenses

LICENSE #1 The Common Development and Distribution License
(CDDL). Version 1.0 aoverns vour use of

@ Jacceptthe terms in the license agreement

€ | do not accept tha terms in the'license agreement

InskaliShield

a ¥ A
3UN a3 naanithisuaeuiau lyvoalilsunsy

5 . 4 PR | 2
1.4 TU50n51 Instalier 92 191315%1) path 1517890150 NetBeans 111151521) path A

a

9 [ d' ;// b c:. /"1 1] ) o
1599994M15 A1 A4 9N elick 1 Next o lilwihae

& INetBeans IDE 5.5.1 Installer

Click Next to install NetBeans IDE 5.5.1 to this directory, or click browse to install
to a different directory. You must choose a new or an empty directory where you
F have write permission

Directory Name

| |caprogram Filesinetbeans-5.5 1

' v

UM a4 uaasnieo g l952y) path AdoanisaansTilsunsuy

U



113

1.5 Tu/sunsu Installer 9910911 JDK 5 150 6 oy luiniouazuaad path v93 JDK
iy TugzdTusunsw Installler WU JDK version 1.5.0 061unsaiiisias IDK 13nao version

- q 9 o v Y o 4 ot Ay Y 1oy
51e30a0n 19 version M3 190301318 1asdon Browse click N1 Next two lUniiwe 11

7 INetBeans IDE 5.5.1 Installer

Select a Java 2 Standard Edition JDK installed on your machine from the list
below. You can pick a different JOK by typing in its installation directary or using
the Browse button J2SE JDK 1.5 0 or later s required

J25E JOK Home Directory
[p ekt 5.0_o6

Browse

List of suitable J25E JDKs found.on this machine
D\jdk1 5006 (v.1.5.0_06)

InstaliShield

RECTNERTTN IETTI

d' P A a o
3‘1.'7] .5 LLETA9 path Y93 JDK *nwuclumi DINDUNWAUNDT

v

'
=g A

1.6 T1l56n3u Instatler (5uAAA311)51N5% NetBeans a4 1w path 1321] 1ilofas

o - \ R 4 N o ~
Tsunsua3aiuuiosna click 7 Finish oy Tilsnnsy 43314 a6

 INetBeans IDE 5.5.1 Installer

| The Installizard has successfully installed NetBeans IDE 55 1 on your
computer. Choose Finish to exit the Wizard

NetBeans IDE 5 5.1 installation location

d'tempinetbeans-5 61

To run the IDE, launch:
dtempinetheans-5 5 1ibininetheans exe

To uninstall the IDE, launch:

dtempinetheans-5 5 1\_uninstiuninstaller exe

InstaliShield

¥
%

d' Y A a < o
31U a.6 uaaanihnadiomsfiaa’ T sunsuas seuysol
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N o y 3
2. msaaldsiameriannszuudaueun
2.1 msitla 1eJOS NXJ samples project 'I@EJ!,i'iﬁi’E]ﬂ‘ﬁ!,lJu‘i File >Open project ﬁﬂgﬂﬁ 7.7

4 Y VoA
1&291n15 Browse  Mdsdunug lasnneinaadsdiedialdsanls Taoldsnadi0019

wannludsuoudezoglulvames samples

B nyprojectPC - HetBeans IDE 6.1

File Edit View MNavigate Source Refactor

t MNew Project... Ctrl+Shift+N

9 MNew File. .. Chri+n

[« Open Project.., Ctrl+Shift+0
»

Close "myprojectPC"

Open File...

Open Recent File »
Project Group »
Set Main Project »

"myprojectPC" Properties
Save As...

Page Setup...
Print. ..

Print to HTML, ,..

Exit

gﬂﬁ .7 1ErAIN151la 1eJOS NXJ samples project

2.2 diohmstlaTsnadaedaynund lilsinaaes asgias

| 9 <amples

| Fle Edit view Favorites Tools Help

@Beck v x’b - Search Folders | %}~ g:eﬁ:} Falder Sync

BlueStats . NXTServoTest & .project
‘BTConnectTest . PerformanceTest @ build. xml
BTGPS . PFTest 4 manifest, mf

) Make a new Foider ) ’
BTReceive . PilotTester i samples.propel

@ Pubiish: this Folder to the
el

BumperCar . RCNavigator
ColorDetector . RCXEmulator
. CompassTest . RCXMMTest
. DistanceTest i RCXMuxTest
. ‘DLTest . RCXPortTest
. ExceptionTest . -RCXRemote

sa Share this folder

v
@  a

31N A.8 eraans Browse lildadwmialaianesidansdandialision
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2.3 intuviinsadiallsinnlvilaon1s 117 file > New Project >Java>Java

Applicaton ngﬁﬂaﬂﬂu Next ﬁﬂgﬂﬁ 7.9

® Project_name - HetBeans IDE 6.1

File Edit Wiew Mavigate Source Refactor

¥ | New Project... Ctri+Shift-+N

¥ New File... Chrl+N

(&5 Open Project... Ctrl+Shift+0

»

Close "Project_name"
Open File. .,
Open Recent File 3
Project Group »
Set Main Project 4

"Project_name" Propetties

ChrleE

3N a0 uepamsad s lsonlng

Vv L o ot L '
2.4 ninuuldihnisasdie 1san Tuifi 195931 “Project name” famunlasan

< ° @ ' @ a @ :
wuldsin uagdmuaauaonsdandagy udandnifu Finish dagui a.10

’ Hew Java Application x

Steps Name and Location

1 Choose Project Project Name Project_name
2. Name and Location .
Project Location:  CHlejos_rix)\projects ; Browse... |

Project Folder: . C.\lejos_nxilprojects\Project_name

"} Use Dedicated Folder for Storing Libraries

("] Create Main Class st rae
‘v Set as Main Project

il

[ <sak | | Fmsh 0 cancel [ hep |

3UN A0 namsmsmsAsye li/sion
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g’/ ~ k4 - @ P
2.5 mnviuazalsing Tswanade 13 luuny Project Asgii a1

Proj... 40 x Files Services
+ &% myprojectPC ~
+ & myprojectPC_all
+ 38 pcsamples
+ '} Source Packages
+ _(j Test Packages
+ g Libraries
+ g TestLibraries
+ % robotproject
- &» samples

=} b4

i 3
sUM At waaali)snangnadiauy

2.6 nniulyiinsaanuninlysieafiaiialdiden Propertics > Libraries > Add

jar/folder uaihmiy classes.jar c’?iaag"lu .Mejos_nxj\lib ﬁvﬂgﬂ‘ﬁ f.12

Project Properties - Project name X
“ateqgories:
Sources Java Platform:  JDK 1.6 (Default) ¥ Manage Platforms. .. i
Libraries , SRR )
P
S (A ¥ ¥ B T
Compiling .
Compile  Run  Compile Tests Run Tests
Packaging

¥ Add JARFolder

=] Jfreechart-1.0.11.jar «| pctocls.j: 78> UseRelative Path: . f- s
- Bk ] serviet, g
v] inputzjar ] serviet e - J. libfelasses. jar =
] Joystick. jar -‘i[ substanc
«] ftools. jar +] swhgrapt Use Absolute Path:
:J jfreechart-1.0.11-experimental. jar ﬂ junit. jar s C:\lejos_nxjilibiclasses. jar
_a] ifreechart-1.0.11-swt. jar »| pecomm. jar
< b
File name: classes. jar
Files of type: Classpath Entry (folder, ZIP or JAR file) v Cancel _}

Compile-time libraries are propagated to all library categories.

UM a2 uamsmaminaaraaslulisien
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2.7 ¥m3a3ie Java Package Tagnanui Ia@es Source Packages >New>

117

Java

. 4 ddq vl oL e
Package 112711715 1850904 Java Package Tu 195991 “org.me.myproject™ A3 .13

Q Project_name - NetBeans IDE 6.1 b
File Edit View Navigate Source Refactor Build Run Profile Versioning Tools Window Help

:y

gpl. g ooy i i T S )
Yo e Sdefodconfig> el ¢ @ D
Proj.. 4i x Files Services ...ava [ ] PCcontrol.java x i Camera_Control.java »
# & myprojectPC “' | Source  Design R g
+ % myprojectPC_all YRS =
+ Ak pesamples 1671
- % Project_name 1672
= .3 Source Packages 1673
“7 1*(“ % New » & JavaClass,
est Packages
t - Find. ChME ™ JFrame Form,
+ & Libraries
+ g Test Libraries ) Folder
+ & robotproject Copy CtrleC L.l Java Package...
2 '  Java Interface
PCcontrol.java - Navigator
;IPanel Form
Members View G

" Entity Class..,

= ' PCeontrol
PCeontrol() Fiscorve okl ¢ Entity Classes from Database
% FormwindowClosing( S ihes
@ _ntCompanents() Compile Package  F9 .
@ jButton10ActionPerfo- Local History ¥
% jButton!1ActionPerfo
& jButton12Actionperf 0% e =
% jButtonl4ActionPerfarmed (s Lé8s
@ jButton)SActionPerformed(- Yoo\ s
& > 1691

FUN A3 UARINITAT 1IN

v i
2.8 MAUUMINTAT19 Java main class 1A8A1TAANUIA Package org.me.myproject

>New>Java class uazﬁwmﬂd%‘vm Java class iuﬁﬁi‘fﬁﬂﬁ “HelloWorld” ﬁ&gﬂﬁ .14

Proj.. 4 x  Files Services ..ava | PCoontrol.)java x5 Camera_Controljava x
* ? myprojectPC | sowce < Design QL&D 4
+ % myprojectPC_all s (1
+ % pcsamples 1671
- % Project_name 1672 |
- .} Source Packages 1673 &
{24 org.me.myproject New ¥ . JavaPackage...
..y Test Packages
Find. .. Chri+F &, Java Class...
+ g Libraries ,
+ g Test Lbranes Cut Chrl+x FomeFony. .
+ &% robotproject Copy Chil+C ) Folder...
e i i 4., Java Interface...
Navigator
{., JPanel Form...
Delete Delete il 2
R setor &, Entity Class. ..

& Entity Classes from Database. ..
Reverse Engineer ...

‘3': ‘ Other...

Compile Package F39
Local History »
Tools »

IL-1.T-

1689

1690

1691

UM a4 uaaamsadeamalullsien
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) 4 w4 y
2.9 nviuimsud luldaniolu e Helloworld 1Wiiludsgalit 15 ienaaeums

Mauvee 1sunsy

package org.me.myproject;
import lejos.nxt.*;
public class HelloWorld ({
public static void main(String(] args) {

System.out.println("Hello World");
Button.waitForPress () ;

5N aasuaaenisud luldanioTu'lWa Helloworld

2.10 INUUNING copy IWa¥® build.xm! 1naa0191U5waN Taidla131ude 1.1 uag

1.2 "lﬂ"li'éfaiﬂamag Source Packages ﬁﬁgﬂﬁ .16

File Edit Wiew MNavigate Source Refactor

Proj... 41 x Files Services
L e

+ &5 myprojectPC_all

+ 3@ pcsamples

-~ #: Project_name
.} Source Packages

= oorgume,myproject

o PHelloworld, java
Uy Test Package

+

+

gy Libraries
+ g Testlibraries
%% robotproject
& samples

- ..} BlueStats

+ ;3 BTConnectTest
+ .3 BTGPS
+ ..} BTReceive

ST - NP S

31 A.16 uaAans copy 1Wa%e build.xml 9andees Tilsiaii 1diTa 13 T dalnames

Source Packages
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[

z’x’z a o 43 o g
2.11 9nuutla 14 build.xm! Yumudvimsud luaail

o 3
e 11/asudpAY <basename property="program" file="."/> L‘L|u<property

name="program" value="HelloWorld">
® himsnw property:
<property name="class" value="org.me.myproject.HelloWorld">
g’/ ' . d' Y :;d Y
® mﬂuu“lumu link target, WasuussnantIony

o
<arg value="${program}"/> 1)1 <arg value="${class}"/>

¥ o A ' . ¢
2.12 TANIYNINT copy Taniiyea sample.properties nlvaaes

...\lejos_nxj\projects\samples T B ldanes lsnanddiwan Tuiitide Ilanesye

Project_name ﬁﬂgﬂ‘ﬁ 17

Tools  Help

earch Folders { :‘Z - (v‘; Folder Sync A Search Falders E' ‘j‘? Folder Sync
£

. 'BlueStats . 'NXTServoTest & .project \4-,;:7; S

;. /BTConnectTest . PerformanceTest  » build.xml - nbproject w J Si¥
« BTGPS . PFTest Lhsnanibachaak 4.

. - BTReceive Pilot Tester l -’ samples. properties I E o .l buid. xml
. -BumperCar . RCNavigator - et ’d‘

+ - ColorDetector « RCXEmulator L B

. ‘CompassTest . RCXMMTest “‘ maftest. mf

. DistanceTest « RCXMuxTest

. DLTest « ‘RCXPortTest

+ExceptionTest . RCXRemote

P St A . o . .
31]71 .17 LLEAAINIT copy Ivlaniiaen sample.properties nlanos ...\lejos nxj\

projectsisamples 111364 Inlaunn$ 1) swandaviomn

y 9y @ o @ 1 o o y 1 ' 1 4
2.13 tipdnanison Tnaa Ivld l)dajueudldnmsisenaeszninesusuduaginiog
a d Y A ¥ Y o a) 1 4 Y o a a
ARNAARIAIBEI  USB 30 ugys anuuliiimsitlayueud udnihinisadnuni
5 y o a ] 2 4 '
build.xmI>Run Target>uploadandrun 310U UNIN upload dusvvgiivonnuvunuiy Output I
“BUILD SUCCESSFUL" #1331/#1 .18
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+ % pesamples

- & Project_name 8L
- .} Source Packages 9
= |4 org.me.myproject 10 i
21 PHelloworld. java 11
i X Bl vt 12 public class He.
+ .} TestPackage Openy
+ @ Libraries Run Target » uploadandrun
+ @ Testlibraries DebugTarget V.3 ‘deen
+ & robotproject Local History ’ compile
+ @b samples Cut Ctel+y link
build.xml - Navigator Col Ctri+C upload
Py
Ant Targets
% » Delete Delete Advanced. ..
i, clean
é‘..‘ compile Rename. ..
o link
- Save As Template. ..
v upload ’ INS
Output - Javaapplical ~ T00Is 4
£ init: Properties

deps-clean:
clean:
BUILD SUCCESSFUL (total time: Q seconds)l

51 a.18 uamsdeamsan Inaa Tuld gy ueud

P el J/ 4
3. msadnldsiameiainszuudunieeniuni(pPC)
3.1 ymisada T sion v Taoms 1R file > New Project >Java>Java Applicaton

udnantju Next 43317 A.19

' Project name - NetBeans IDE 6.1

File Edit Wiew Navigate Source Refactor

¥ | Mew Project. .. Clri4+5hift+M

T hew File. ., Chrl+h

=% Open Project... Ctrl+Shift+0
>

Close "Project_name"

Open File. ..

Open Recent File 3
Project Group »
Set Main Project »

"Project_name" Properties

Chrls

UM a9 uamsmsade T sl
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y o | Adq yd . 5 < A
3.2 nnuulviinslaye Tuswa Tunii19¥091 “Project PC_name” fnualaiznne

v Tdson uazdmuadudenaisnasgl) udananiy Finish A3 a.20

% Hew Java Application

Steps Name and Location

1. Choose Project Project Name: Pvmect_PC_nameI
2. Name and Location

Project Location:  C:\lejos_nxj\projects | Browse.. }

Project Folder: C:ilejos_nxjiprojects\Project_PC_name

[ Create Main Class

[v] Set as Main Project

3 n20 uamensasiio Tsiauaz lasanesinulisen

Y
3.3 DINUUHIINITAANY

L]

Wlswanadialdiden Properties > Libraries > Add

'
o W

jar/folder ud2¥1n50Wn Tau 31594

Zhe

® pccomm.jar L& petools.jar “?ﬁﬁ)tﬁu .AMejos nxj\lib
- : : .
® Dbluecove,jar clmf]gslu..\lejosﬂnXJ\BSrdparty\hb

A o A o & = 4 9 4 & v
Luﬂm1ﬂ1§!wuhlaU5151’]31’1“9’1“!!@3 ﬂ]UiuiﬂﬁI%ﬂ‘ﬂﬁi%ﬁ‘uuuuﬁ’lu’ﬁﬂas)ﬂ

java class ldana
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1
d o

YUADUNITANNI Java Media Framework 139594 2.1.1e

1. A17% I1aA Java Media Framework 199594 2.1.1e 18910 http://java.sun.com/javase/

technologies/desktop/media/jmf/2.1.1/download. ﬁdgﬂ‘ﬁ 1.1

Required Files

N

i

Windows Performance Pack 493 MB

2 mi-2_1_te-windows-iS88 axe

g 4.1 nansdaultaraniTuaalusunsuaindy lod

@ 2 a a o § & a ¥ W ~
2. ﬂ‘ijmaﬂaﬂ'ﬂulﬂajmf-2_l_le-windows-i586.cxe WOIFUN1IARAY ﬂﬁg‘ﬂ‘ﬂ 3.2

= Local Disk {C:}
File Edit View Favorites Tools Help

Search Folders | %~

i
]

pal=> (2
e
;" Documents and Settings ' program Files
=3 it
| WINDOWS { leios )
' §
4 testimages i Picvictims

3

o' 271 \evu w585 #vg
sckager o Theweh Shis
st 6 Softear® COrom .

a' Y @ ay a d . = [ d' Y
3. watldvinmsatananTWa jmf-2 1 le-windows-is86.exe 1ansnazili 4.3 1na “yes”

v v
WA UNTAAAIAD
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Software License Agreement

: Please read the following License Agreement  Press the PAGE DOWN key to see
L the rest of the agreement

| JavaTM Media Framework [JMF) 2.1.% »
Binary Code License Agreement

READ THE TERMS OF THIS AGREEMENT AND ANY PROVIDED
SUPPLEMENTAL LICENSE TERMS [COLLECTIVELY "AGREEMENT")
CAREFULLY BEFDRE OPENING THE SOFTWARE MEDIA PACKAGE. BY
OPENING THE SOFTWARE MEDIA PACKAGE, YOU AGREE TO THE TERMS
OF THIS AGREEMENT . IF YOL) ARE ACCESSING THE SOFT'WARE
ELECTRONICALLY, INDICATE YOUR ACCEPTANCE OF THESE TERMS BY
SELECTING THE "ACCEPT" BUTTON AT THE END OF THIS

AGREEMENT. [FYOU DO NOT AGREE TO ALL OF THE TERMS, PROMPTLY
RETURN THE UNUSED SOFTWARE T0O YOUR PLACE OF PLURCHASE FOR A
REFUND OR, IF THE SOFTWARE IS ACCESSED ELECTROMNICALLY,
SELECT THE "DECLINE" BUTTON AT THE END OF THIS AGREEMENT

4

Do you accept all the terms of the preceding License Agreement? If you choose No, Setup
will close. To install IMF, you must accept this agreement

< Back Yes No

A < a o Sy
suUn a3 uraslaordonsunsfedsIMF

o o & @ 4 y
4 axlnnguine idenTWamesdawnaidesnisfadslisunsy a3 4.4 Weiden

TWawosdaromandalinan “Next

Choose Destination Location

Setup will install JMF in the fallowing falder.
To install to this folder, click Next.

Toinstall to a differsnt folder, click Browse and select another
folder.

“(ou can choose not to install JMF by clicking Cancel to exit
Setup.

Destination Folder

C:A\Program Files\MF2.1 1. “‘E"I_C'WSE»-

< Back Cancel g

1 o = a &
3UN w4 uaasie iden Iamesaonandesnisaadalilsunsy IMF

5. v ng1¥iden Option veslUsunsy IMF Aideanis Aagiit 4.5 2antiundn “Next
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Select Components

Select Setup Options

W Uninstall earlier versions of JMF:

¥ Copy files needed to run in AppletYiewer of JDK 1.2+

v Move DLLs to Windows/System directory (recommended)
V' Make necessary changes to PATH and CLASSPATH
v Permit recording from an applet (See readme. html)

I Permit writing local files from an applet [See readme. kitml)

¢ Back I Newt » ] Cancel f

3UM 3.5 uanas Option voeT1l5uns N IMF

6. wwUnngrieiuananaduiiunsasTisunsu IME d331)# 1.6

2 Java Media Framework 2.1.1e Selup

Java Media Framework 2.1. 1¢e

I “Cancel |

d' Y d' o a
FUN w6 uanamiveiuanimsduiiumsaslsunsu IMF

7. wieasTsunsuade ewsadlaldaon lusunsu 18 1aon 106 I amesiuiy Tasunsu135

' a a’/ g’/ 4 Qo ‘:l
dldidenaounoudanalusunsy vimiudenii IMStudio #3171 4.7
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Mr.Today }

g Internet

. E-mail

dald

ﬁ Notepad
Adobe Reader &

@ Microsaft Office Wor

a;‘; Microsoft Office Pow,
L2 2003

Thaifoltvear e Diction

@ NetBeans IDE 6.1

5 SoundMAX

3 Startup

4 Internet Explorer

43 Outlook Express

.. Remote Assistance
& Windows Media Player
i Windows Movie Maker
7} CDex

7} ThaiSoftware Enterprise
) COD10

© Babylon

AR smart

) AVGFree 8.0

7} Microsoft Office

4 PDFCreator

™ HP

T4 Ws_FTP

Adobe Reader 3

# ) Royal Institute Dictionary

@ ) Download Accelerator Plus (DAP)

o EditPlus 3

! S wirar

; Q Adobe Photoshiop 7.0

¥ T winZp

& JavaMeds Famework 2.1, 16

s

£} Documentation
8 l JMF Customizer

Fr MF Registry

3UN .7 naasniswe T sunsy IMF

. Y . 1
8. ieolallsunsuuda 1ideniing File > Capture #3317 4.8

IMStudio

Open RTR Session...

Caplure, . ClilrP

Recent URLs

#0 Player Help
Mew Windaw
Open File..
Qpen URL..

Transmit...

Preferences. ..
Exit

Cri+M
Ctri+0
Ctri+U
Ctrl+R

»

Ctrl+T

Clrl+x

3N 1.8 uansduAaner 1FveTisunsy IMF
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¥ Y b ik v A ' 0 ' vls/
9. mﬂuu%zﬂimgﬁmma “Select Capture Device m%ﬁ1u15ﬂlﬁ@ﬂﬂﬂUﬁ'}UﬁNﬂ AN

AoaMs A3 1.9

| Encoding: (YUY  ~ dd ke 0 S LIRERR S | 0

Video Size: |640 x 480

Frame Rate: [15.0

YUV Type: YUYV

3UN 1.9 uAAINTEI9 “Select Capture Device” 493 T1/51n 53 IMF

10. efmuamiuuiovnda Wnagly “ok” s nguiimaaainanshnuvendes

s a.10

1 w0 - IStudio o TE e
File Player Haip

il 00:00:45.98 H

qil‘ljﬁ 3.10 LLﬂﬂQWﬁJWS"iNLLﬁﬂQWﬁﬂﬁﬁNTU‘lﬁNﬂgﬁN
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aemsl¥NuIzUUAUMYsza Uy

1. Wanetwamiuszundumdiszauss Azl a.1

5 Victins Déscovery System -0 X

TR
i ey :M
octiinfo | war 1| s e s

E
i Status
|
|
|
|

Diveomient

— Signal

‘ —

: ) = 9
2

\ -

|
™ b
KL . i

NXT 11 Info
Status

cTHELLBABEE
Y

i \ ) natiaYiing
Hoand | L A+ @rseshis | o0 Ao : 9 i danda |,

catiresporll. simt > P : ] e 07 1 atemtervar 5
- i Wi 900

51 a1 wansmmaaseiullFveszuuRuIH s A UAY

' . A e A Y o o ad 3
2. 09 ﬂiJ “Connection all” LwammiwamﬂﬂmmumasmmuazwumsQquumg“luﬂﬂ
' d A ' @ a
UUIUA WIUNNATOVIVYND ﬂﬂgl"ﬂ 9.2
L1 Victims Discovery System -0 %
st
.
NG L
: e
NXT 1 Info i 0114 %3 Gehg T
@ ‘? U neowes )
‘ ¥ sound * W oo gy e) ]
[ Captun Sevier (B l B R Undote nterest o 10 cewean ¢ m(«..;ri
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' § o o o ad ¥y J
3.0 1Ju “Start™ Vo udOYANINIUIYESITUazIITD T g Rog TUAT UIUA Mg

Y

w3 eteugns uaaslugluuyvosdaay JUam uaznamidudagzili 0.3

L Victims Discovery System N
Fe Wi
o AT { ﬂ I
L% z i NXT Tinfo {3
Status e
- a8
—
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